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INTRODUCTION TO REALPRODUCER PLUS
Welcome to RealProducer Plus G2 from RealNetworks. This tool 
converts standard audio and video files into streaming media clips. 
Utilizing easy-to-use assistants, a simple interface, and customizable 
settings, RealProducer Plus is perfect for either novice or advanced 
content creators. In addition, you can also use this tool to publish 
your RealMedia files, adding sight and sound to your Web site.

New Features for G2
This version of RealProducer Plus includes new features that allow you to:

• Record for multiple audiences using SureStream™

• Create RealMedia clips that automatically switch down to a lower 
bandwidth during network congestion

• Create RealMedia clips compatible with older versions of RealPlayer™

• Create improved-quality RealAudio® G2 audio output and RealVideo® G2 
with Intel® video output

• Use a more flexible and usable interface

• Convert compressed QuickTime® files

• Customize target audience settings

• Monitor statistics during a recording session

About This Manual
Chapter 1: Installing RealProducer Plus explains installation procedures 
and provides information about system requirements for installing and using 
RealProducer Plus.
1
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Chapter 2: Using RealProducer Plus explains how to create streaming media 
from existing files. It also describes how to choose a target audience, how to 
use SureStream, and how to monitor the recording process.

Chapter 3: Publishing to the Internet discusses how to generate streaming 
media-enabled Web pages and publish those Web pages to a server.

Chapter 4: Customizing Recording Options explains how to change 
RealProducer Plus preferences and how to modify target audience settings.

Chapter 5: Recording Tips provides information for increasing performance, 
using RealProducer Plus more efficiently, and creating high-quality audio and 
video.

Chapter 6: Using AppleScript shows you how to use the RealProducer Plus 
script commands.

For More Information
For additional information about using streaming media effectively and how 
to create multimedia presentations with your clips, refer to the RealSystem G2 
Production Guide, available for download from the RealNetworks Web site at:

• http://service.real.com/help/library/index.html

For technical support with RealSystem G2, please fill out the form at:

• http://service.real.com/contact/email.htm

The information you provide in this form will help technical support 
personnel to give you a prompt response. For general information about 
RealNetworks' technical support, visit:

• http://service.real.com/help/call.html
2
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 Chapter 1: INSTALLING REALPRODUCER PLUS
Installing RealProducer Plus is quick and easy. You can download 
RealProducer Plus from the RealNetworks Website or install it from 
a CD-ROM. Before you begin, make sure your computer meets the 
necessary system requirements. See “System Requirements” on page 
4 for more information.

How to Install
Follow this procedure to install the product onto your computer.

➤ To install RealProducer Plus:

1. Download the installation program, or insert the CD-ROM into your 
drive.

2. Close any other applications that may be open and double-click on the 
installation program icon.

The installer begins by preparing your system for RealProducer Plus. 
When complete, the installer opens to the Software License page.

3. Read the terms and conditions carefully, and click Accept if you agree. 
You can click Cancel at any time to abort the installation.

4. Enter your e-mail address in the appropriate field. 

5. Modify the directory RealProducer Plus will install into by clicking the 
Browse button and selecting the new path.

6. Enter the serial number you received when you purchased RealProducer 
Plus.

7. Click Finish.

The install program installs all necessary programs and opens 
RealProducer Plus.
3
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System Requirements
This section outlines the basic hardware and software requirements needed to 
run RealProducer Plus.

The following table lists the minimum and the recommended requirements 
for converting existing audio and video files into RealMedia files:

You must have an FTP program installed, either Anarchie or Fetch, to use 
RealProducer Plus’s Web Publishing features. Go to http://
www.stairways.com for information on using Anarchie.

Recording from Files

Requirement Minimum Recommended

CPU Power PC 120 MHz 
604

Power PC G3

Operating System 8.1

RAM 32 MB 64 MB

Hard Disk space 
(software)

8 MB

Hard Disk space (data) 10 MB 1 GB

Color Display 16-bit 24-bit (TrueColor)
4
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 Chapter 2: USING REALPRODUCER PLUS
This chapter describes how to use RealProducer Plus to convert 
standard audio and video into streaming RealMedia. The entire 
conversion process is known as a “recording session.” Here, you will 
learn how to create a recording session, how to record with 
SureStream, and how to monitor your recording session.

What is Streaming Media?
RealMedia clips created by RealProducer Plus are streaming audio and video 
presentations, also known separately as RealAudio and RealVideo. Prior to 
RealMedia, one had to wait for a media file to download in order to play it. 
When you create a streaming clip, users can play it almost instantly.

By streaming a clip, you are sending small packets of information over a 
connection. On the other end, the user receives the information and plays 
your media clip bit by bit. The process is almost invisible to the user, except for 
a small amount of initial buffering.

RealProducer Plus G2 is an integral part of the RealNetworks RealSystem G2. 
RealProducer Plus creates the clips, RealServer™ sends the clips, and 
RealPlayer™ shows the clips.

The RealProducer Plus Main Window
Before you begin to create RealMedia content, let’s briefly tour the different 
components of the RealProducer Plus main window. This window is where 
you create, start, view, and stop a recording session.
5
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The RealProducer Plus Main Window

The upper section of the window is where you monitor the recording process. 
“Viewers” show you the input video and the recorded output during a 
recording session. Meanwhile, an audio level indicator gives you a visual 
representation of the audio track.

The middle section lists all necessary information about the final RealMedia 
file. Details such as clip information, the target audience, audio format, video 
quality, and the type of stream being recorded are found here.

On the bottom are the recording controls. These controls allow you start, 
stop, and play the current recording session. Also located here are the 
publishing controls. They are explained in “Publishing to the Internet” on 
page 25.

Creating Streaming Media
RealProducer Plus includes a simple assistant to guide you step-by-step 
through the recording process. This assistant is specifically designed to 
convert existing audio and video files into RealMedia files.
6



RealProducer Plus User’s Guide CHAPTER 2: Using RealProducer Plus
If you are more familiar with the recording process, you can bypass the 
assistant and set up the recording process manually. This option is discussed 
later in “Recording Without the Assistant” on page 15.

Recording from Media Files

This section describes how to record a RealMedia file from different types of 
existing media files using the recording assistant.

Only the following audio and video formats can be converted into RealMedia 
clips using RealProducer Plus:

• Audio (.au, .aiff, .snd, .wav)

• QuickTime for Windows (.mov); must be QuickTime 3.0 compatible

➤ To create a RealMedia file from an existing file using the recording assistant:

1. Select Recording Assistant from the File menu.

The Recording Assistant opens.
7
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2. Use the Browse button to locate the audio or video file that you will use 
as the source for your recording.

3. Click Next.

The RealMedia Clip Information page opens.

4. Enter the following information in the provided spaces. This information 
will appear in the viewer’s RealPlayer when your clip is played. You may 
leave them blank. 

Title—the title of the clip

Author—the name of the clip’s creator

Copyright—year and owner of the clip’s copyright

5. Click Next.

The File Type page opens.
8
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6. Select the type of RealMedia file you want to create: SureStream or 
Single Rate. For more information on SureStream files, see “About 
SureStream” on page 16.

7. Click Next.

The Target Audience page opens.
9
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8. Select the connection speed for your audience. You may make more than 
one selection if you are creating a SureStream file.

9. Click Next.

The Audio Format page opens if your source file contains audio. If not, 
skip the next step.
10
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10. Select the type of audio that your file consists of (if applicable), and click 
Next.

Note

You can only select the Stereo Music format if your 
input audio is in stereo.

The Video Quality page opens if your source file contains video. If not, 
skip the next step.
11
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11. Select the video quality for your output file (if applicable), and click Next.

The Output File page opens.
12
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12. Enter the name and directory of your final output file.

The output file must have a .rm extension (for example, myfile.rm).

13. Click Next. 

The Prepare to Record Page opens.
13
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14. Review all information regarding your file. If it is correct, click Finish. 
You can use the Back button to reverse through the assistant and change 
any information.

After clicking Finish, you are returned to the RealProducer Plus main 
window. If you are recording video input, the Input Source viewer shows 
the first frame.

15. You can change any recording options at this point, or simply click Start 
to begin recording.

16. Click Stop to quit recording before the source file ends.

A dialog box opens asking you to confirm ending the recording, but the 
session continues to record.

17. Click Yes to close the dialog box and stop the recording.

The Recording Complete dialog box opens. This dialog shows you final 
recording information about your RealMedia file.
14
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18. Click Statistics to view complete information about your recording 
session. See “Monitoring Recording Statistics” on page 17 for more 
information.

19. Click OK to return to the main window.

20. Click the Play button to open your RealPlayer and play the RealMedia file.

Recording Without the Assistant

Although using RealProducer Plus’s recording assistant allows you to easily 
create RealMedia content, after time you’ll likely be able to do without it.

➤ To create RealMedia without using the assistant:

1. Select Open File from the File menu.

The Open File dialog opens.

2. Navigate to the file you want to record, and select it.

3. Click the Choose button.

The Open File dialog closes, returning to the RealProducer Plus main 
window.

4. Enter the Title, Author, and Copyright information for your output. 
These fields are optional.

5. Select the File Type, either Single Rate or SureStream. For more 
information, see “About SureStream” on page 16.

6. In the Target Audience section, select the connection speed for your 
audience. You may select more than one target audience if you are 
recording with SureStream.

7. In the Audio Format section, select the type of audio contained in your 
source (if any).

Note

You can only select the Stereo Music format if your 
input audio is in stereo.

8. In the Video Quality section, select the type of video contained in your 
source (if any).

9. Click Start to begin the recording process.
15
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10. Click Stop to end the recording.

About Target Audiences
Whenever you create a RealMedia file or broadcast RealMedia content, you 
should always keep in mind the connection speed of your audience. Are they 
using lower-speed modems, or are they streaming your file over a high-speed 
network?

When you select a specific target audience, you are actually specifying a 
maximum bandwidth for your RealMedia stream at the selected target 
audience. Bandwidth, measured in kilobits per second (Kbps), is the amount 
of data that can be sent through an Internet or network connection during a 
set period of time. Standard modems are commonly referred to by the 
bandwidth they are able to receive--for example, 28.8 and 56 Kbps.

In addition to these standard audiences, you can record clips for connection 
speeds of 100 Kbps, 200 Kbps, or higher. These higher bandwidths, however, 
are generally more typical of corporate Local Area Networks (LANs) or 
entertainment-based Web sites.

Keep in mind that the maximum bandwidth a connection is capable of is 
greater than the average bandwidth carried across it. For that reason, 28 Kbps 
connections actually only use approximately 20 Kbps, while a 56 Kbps 
connection actually uses about 34 Kbps.

Normally, these constraints can affect your recording in many ways. 
Sometimes you have to compromise between reaching the largest audience 
(with the lowest-speed connections) and the quality of your work. Fortunately, 
RealProducer Plus enables you to record for a number of target audiences 
simultaneously using SureStream.

About SureStream
With SureStream recording you can reach the widest possible audience, and 
provide all users with the best listening and viewing experience optimized for 
their bandwidth.

There are several advantages to using SureStream. You can create:

• a single RealMedia clip recorded for multiple target audiences 

• a clip that will automatically switch to a lower bandwidth during poor 
network conditions
16
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• a clip that is compatible with an older version of RealPlayer

SureStream RealMedia files can combine several different streams that take 
advantage of any or all of these features.

For example, you can record a video clip for both 28 Kbps and 56 Kbps 
audiences, and RealPlayer G2 will automatically use the correct stream based 
on the user’s connection speed. Meanwhile, a separate stream can exist for 
people who still own a RealPlayer 5.0 so that they can experience your clip. All 
streams are contained within a single RealMedia file.

Keep in mind that if you will place the SureStream files created with this 
product on a server, you must use a RealNetworks RealServer G2.

Monitoring Recording Statistics
The Statistics window is a useful tool that allows you to monitor the 
performance of your recording session.

You can watch general statistics, audio-only statistics, or video-only statistics. 
Plus, if you are using SureStream, statistics are shown for each stream that 
RealProducer Plus creates.

➤ To monitor recording statistics:

1. After you have created a recording session, choose Statistics from the 
View menu.

The Statistics window opens. You can return to the RealProducer Plus 
window without closing the Statistics window.
17
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2. Start recording, noting the top section of the Statistics window. Here is 
where you will find basic information about your recording session such 
as:

• name and location of the input file

• name and location of the generated output file

• audio format and video quality

• whether the output is SureStream or Single Rate

You also find information that constantly changes, such as:

• time remaining in the clip

• real time performance
18
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3. Also monitor the general, audio, and video information located at the 
bottom of the Statistics window. These statistics are described later in this 
section.

Monitoring Real Time Performance

A main feature of the statistics dialog is its ability to show the performance of 
your recording session.

This statistic compares the time it took to record your clip to the time it takes 
to play the input. For example, if your input is a 10 second video clip and it 
takes RealProducer Plus 5 seconds to process the clip, the Real Time 
Performance would be 50%.

Any value near or above 100% means that your computer may not be able to 
process data as fast as it is received, and the session may fail due to lack of 
computing resources.

General Statistics

These statistics give you information about each target audience selected 
during the creation of the recording session. If you are recording a Single Rate 
clip, only one stream appears. If you are using SureStream, all streams are 
listed for each target audience.

See the table below for more details about these statistics.

Using General Statistics

Statistic Description

Target Audience target bit rate of your audience

Total Bit Rate total bit rate of the clip

Video Bit Rate bit rate of the video stream

Audio Bit Rate bit rate of the audio stream

Frame Rate frames per second of video

Buffer Time number of seconds needed before the 
clip can be played
19



CHAPTER 2: Using RealProducer Plus RealProducer Plus User’s Guide
Audio Statistics

These statistics give you information about the audio codecs (compression/
decompression algorithms) used to create the audio streams. More than one 
codec appears if you are using SureStream.
20
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See the table below for more details about these statistics.

Video Statistics

These statistics give you information about the video codecs (compression/
decompression algorithms) used to create the video streams. More than one 
codec appears if you are using SureStream.

Using Audio Statistics

Statistic Description

Audio Codec codec being used to convert audio 
stream

Frequency Response highest frequency found in the 
recorded audio

Real Time Performance approximate percentage of your 
computer’s audio recording speed 
compared to real time audio playing 
speed
21
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See the table below for more details about these statistics.

Using Video Statistics

Statistic Description

Video Codec codec used to convert video

Video Bit Rate bit rate of the video

Frame Rate frames per second of video
 (Table Page 1 of 2)
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Quality Index video quality affected by your 
computer processor’s recording speed; 
100 is best, and values less than 80 
reflect reduced quality

Real Time Performance approximate percentage of your 
computer’s video recording speed 
compared to real time video playing 
speed

Using Video Statistics (continued)

Statistic Description

 (Table Page 2 of 2)
23
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 Chapter 3: PUBLISHING TO THE INTERNET
Along with its powerful recording features, RealProducer Plus 
includes assistants that allow you to publish your streaming content 
to the Internet. Using these assistants, you can create a RealMedia-
enhanced Web page and upload it to a server.

Creating Web Pages
A primary publishing feature of RealProducer Plus is the Web Page Assistant. 
With this assistant, you can instantly create a Web page enhanced with 
RealMedia. The assistant creates all of the HTML necessary to provide a page 
that contains your streaming media file. 

Guided through a series of prompts, you choose how to stream your 
RealMedia file: either with a RealPlayer in a separate window, or with a 
RealPlayer embedded within the page. The assistant then allows you to 
preview the finished page with your Web browser and a RealPlayer.

Follow these steps to create either type of RealMedia Web page, pop-up or 
embedded.

➤ To create a Web page that opens a separate RealPlayer:

1. Select Create Web Page from the Tools menu.

The Web Page Assistant opens to the Introduction page.

2. Click Next to begin the assistant.

The Media File page opens.

3. Select a RealMedia file.

The name of the last RealMedia file created by RealProducer Plus appears 
by default. Click the Browse button to locate another file.

4. Click Next.

The Playback Method page appears.
25
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5. Choose Pop-up Player and click Next.

The Web Page Caption page opens.

6. Enter text that will appear in the Web page that, when selected by a user, 
will open the RealPlayer and play your file.

7. Click Next.

The Web Page Filename page opens.

8. Enter the name and directory of the Web page you want to create.

9.  Click Next.

The Web Page Results page opens. This page informs you that a Web page 
and a RealMedia metafile have been created.

10. If you wish to preview your Web page with an Internet browser, click 
Preview on the Results page.

You must have RealPlayer installed to view your page properly.

11. Click Finish to close the assistant.

➤ To create a Web page with an embedded RealPlayer:

1. Select Create Web Page from the Tools menu.

The Web Page Assistant opens to the Introduction page.

2. Click Next to begin the assistant.

The Media File page opens.

3. Select a RealMedia file.

The name of the last RealMedia file created by RealProducer Plus appears 
by default. Click the Browse button to locate another file.

4. Click Next.

The Playback Method page appears.

5. Choose Embedded Player and click Next. 

The Player Control Layout page appears. In this page, you can decide what 
components of the RealPlayer to include within the Web page.

6. Select a control layout from the available options.

7. Select Auto Start if you want the RealMedia file to play automatically 
when your Web page is opened.

8. Click Next.
26
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The Web Page Caption page appears.

9. Enter a caption name that will appear as a title for the RealMedia file.

10. Select whether you want the caption to appear above or below the Player 
controls.

11. Click Next.

The Web Page Filename page appears.

12. Enter the name and directory of the Web page you want to create

13. Click Next.

The Web Page Results page opens. This page informs you that a Web page 
and a RealMedia metafile have been created.

14. If you wish to preview your Web page with an Internet browser, click 
Preview on the Results page.

You must have RealPlayer installed to view your page properly.

15. Click Finish to close the assistant.

Keep in mind that the Web pages you create with the Web Page Assistant will 
initially point to files located on your local hard drive. If you upload your 
pages to a Web server, these local file references will be automatically updated. 
Therefore, you should avoid making manual changes to any file references in 
HTML files created by the assistant.

Alterations to these files or any file references contained in the associated 
.ram/.rpm metafile may cause errors when publishing Web pages to a remote 
server.

About Metafiles

A metafile points a Web page link to one or more RealMedia clips located on a 
remote server. The function of a metafile is to point to the location where your 
media file actually resides and is required for your file to stream, rather than 
simply download and play. Typically, a metafile is located on a server and 
contains the URL where a RealMedia clip can be found. 

Metafiles created by the RealProducer Plus Web Page Assistant reside on your 
local hard drive and point to files on your local file system. When you publish 
your files to a server, these metafiles are automatically updated to include 
information about the server where your media files will be sent.
27



CHAPTER 3: Publishing to the Internet RealProducer Plus User’s Guide
Publishing Your Files to a Server
Another assistant included with RealProducer Plus is the Publish to Server 
Assistant. This assistant allows you to publish your RealMedia-enhanced Web 
page to a remote server. The server can be either a RealNetworks RealServer or 
a standard HTTP Web server.

The assistant leads you through a series of prompts to help you specify the 
type of server and the directory where you will upload your page. You can also 
specify the name of the Web server and the URL directory where your Web 
page will be located. The assistant then allows you to preview the finished 
page.

When you upload your Web pages to a remote server, RealProducer Plus 
automatically updates your Web page and .ram/.rpm metafile to point to the 
appropriate server addresses, directories and files.

To avoid confusion during the publishing process, you should contact your 
Internet Service Provider (ISP) for the following information before you begin. 

Note

You must have an FTP program installed, either 
Anarchie or Fetch, to successfully publish your files.
28
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Worksheet 1: RealServer Information

If you are using a RealServer to stream your files, you will also need to obtain 
the following information from your system administrator or ISP. Please note 
that for streaming from a RealServer your Web page will be copied to a 
standard HTTP Web server, while your RealMedia file may be copied to a 
separate RealServer.

File Server: Name or IP address of the file server where your Web page will be 
uploaded. For example, ftp.server.com.

____________________________

Directory: Name of the directory on the file server where your Web page will 
be uploaded. For example, if the personal directory assigned to you by your 
system administrator is public_html, enter public_html as the directory name. 
This may be left blank.

____________________________________

RealServer: Name or IP address of the RealServer where you will upload your 
RealMedia file. For example, ftp.server.com.

_____________________________

Media Directory: Name of the media directory on the RealServer where your 
RealMedia file will be uploaded. For example, if the media directory assigned 
to you by your system administrator is upload, you would enter upload as the 
directory name.

_______________________________

RealServer Location: Name or IP address of the RealServer that users will use 
to locate your media file. This can include the port. For example, if the full 
URL users will use to locate your media file on the Internet is rtsp://
real.server.com:6060/~username/file.rm you would enter real.server.com:6060 as 
the RealServer name and port.

_________________________________________

URL Directory: The directory on the RealServer that users will use to locate 
your media file. For example if the full URL that users will use to locate your 
media file is rtsp://real.server.com:6060/~username/file.rm you would enter 
~username as the URL Directory. 

_________________________________________
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Worksheet 2: HTTP Server Information

If you are using a standard HTTP Web server to stream RealMedia, you should 
obtain the following information from your system administrator or ISP. For 
simple HTTP streaming, your Web page and media file will be copied to the 
same location.

File Server: Name or IP address of the file server where your Web page will be 
uploaded. For example, ftp.server.com.

______________________________

Directory: Name of the directory on the file server where your Web page will 
be uploaded. For example, if the personal directory assigned to you by your 
system administrator is public_html, enter public_html as the directory name. 
This may be left blank.

_____________________________________

Web Server: Name or IP address of the Web server users will use to locate your 
Web page. For example, if the full URL users will use is http://www.server.com/
~username/file.htm, enter www.server.com as the Web server name.

_______________________________________________

URL Directory: The directory on the Web server that users will use to locate 
your Web page. For example, if the full URL is http://www.server.com/
~username/file.htm, enter ~username as the URL Directory.

________________________________________________
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Publishing to a RealServer

The following instructions are for publishing your RealMedia clip to a 
RealNetworks RealServer. Using a RealServer allows you to publish Web pages 
that have RealMedia without losing functionality (such as SureStream).

Before you begin the procedure, make sure you have all of the information 
described in “Worksheet 1: RealServer Information” on page 29.

➤ To publish a file to stream directly from a RealNetworks RealServer:

1. Click the Publish Web Page button.

The Publishing Assistant opens.

2. Click Next to begin.

The Web Page Filename page opens.

3. Locate the name of the file you wish to publish and click Next.

The Publishing Profile page opens.

4. Choose an Internet Service Provider from the list or select Generic - No 
Defaults if your Service Provider is not listed, and click Next.

The Streaming Method page opens.

5. Click Stream media clip from a RealServer and click Next.

The FTP Server Information page opens.

6. Type in the name or IP address of the file server where you are uploading 
your files and the directory on the file server where your page will be sent. 
Then type in your user name and password, and click Next.

The Web Page URL page opens.

7. Type in the name or IP address of the Web server and URL Directory that 
users will use to locate your page on the Internet, and click Next.

The RealServer Information page opens.

8. Enter the name or IP address of the RealServer where your media file will 
be sent. Enter the directory where your media file will be sent, plus your 
user name and password, and click Next.

The Media Clip URL page opens.

9. Type in the name or IP address of the RealServer where your media clip 
will be referenced from.
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10. Select either Use Default Ports or Use Custom Ports. If you are unsure, 
then use the defaults.

11. Type in the directory of the RealServer where your clip will be referenced 
from.

The full URL of the clip that you are publishing appears below.

12. Check to see that the URL is correct, and click Next.

The Upload Files page opens.

13. Click Next to begin uploading your files.

Your files automatically upload to your Web server. If any errors occur 
while uploading your files, you will receive and error message describing 
the problem and potential solutions.

14. Click View Now! to view your published Web page.

15. Click Finish when you are done viewing your published Web page. 

Publishing to a Standard Web Server

The following instructions are for publishing your RealMedia clip to a 
standard HTTP Web server. While these servers may be more common, they 
don’t allow you to fully use all RealMedia features.

Before you begin the procedure, make sure you have all of the information 
described in “Worksheet 2: HTTP Server Information” on page 30.

➤ To publish a file to stream directly from a standard HTTP Web server:

1. Click the Publish Web Page button.

The Publishing Assistant opens.

2. Click Next to begin.

3. Enter the name of the file you wish to publish and click Next.

The Publishing Profile page opens.

4. Choose an Internet Service Provider from the list or select Generic - No 
Defaults if your Service Provider is not listed, and click Next.

The Streaming Method page opens.

5. Click Stream media clip from a standard Web server and click Next.

The FTP Server Information page opens.
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6. Type in the name or IP address of the file server where you are uploading 
your files and the directory on the file server where your page will be sent. 
Then type in your user name and password, and click Next.

The Web Page URL page opens.

7. Type in the name or IP address of the Web server and URL Directory that 
users will use to locate your page on the Internet.

8. Click Next.

The Upload Progress page appears.

9. Click Next to begin uploading your files.

Your files automatically upload to your Web server. If any errors occur 
while uploading your files, you will receive and error message describing 
the problem and potential solutions.

10. Click View Now! to view your published Web page.

11. Click Finish when you are done viewing your published Web page. 
33





4

 Chapter 4: CUSTOMIZING RECORDING OPTIONS
RealProducer Plus comes with a variety of options that allow you to 
create RealMedia suited to your needs. This chapter discusses how 
to change different recording preferences and how to adjust the 
settings for target audiences.

Changing RealProducer Plus Preferences
RealProducer Plus gives you the option to modify settings that affect all 
recording sessions. This section shows you how to change general recording 
preferences and SureStream preferences. You use the Preferences dialog box to 
make these adjustments.

General Preferences

The General page of the Preferences dialog box allows you to change file 
permission options, the start-up options, and the temporary storage directory 
used by RealProducer Plus.
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The Preferences Dialog Box - General Page

Copy Protection

By changing copy protection options, you are allowing RealPlayer Plus users to 
be able to record your RealMedia clip during playback or download your 
RealMedia clip to their hard drive.

Selecting the Allow Recording preference allows RealPlayer Plus users the 
option of recording the playback of your RealMedia clip onto their computers. 
When your clip is played back on a RealPlayer Plus, the user can click the 
Record button and your clip is saved on the user’s machine. Deselecting this 
preference disables the Record button for RealPlayer Plus users.

Selecting the Allow Download preference gives any user--even those without a 
RealPlayer--the ability to download your RealMedia clip directly onto their 
hard drive.

➤ To allow copying of your RealMedia clips:

1. From the RealProducer Plus main window, choose Preferences from the 
Options menu.

The Preferences dialog opens.
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2. Click the General tab.

3. Select Allow Recording if you want RealPlayer Plus users to be able to 
record your clip.

4. Select Allow Download if you want users to be able to download your clip 
to their hard drive.

5. Click OK to close this dialog.

Temporary Storage Directory

During a recording session, RealProducer Plus uses a directory to store media 
files prior to creating the final RealMedia clip. Using the Preferences dialog 
box, you can change the directory used for this purpose.

➤ To change the temporary storage directory used by RealProducer Plus:

1. From the RealProducer Plus main window, choose Preferences from the 
Options menu.

The Preferences dialog opens.

2. Click the General tab.

3. Click the Browse button, select the new temporary storage directory, and 
click OK.

4. Click OK to close this dialog.

SureStream Preferences

The SureStream page of the Preferences dialog box allows you to change 
different options when you record SureStream RealMedia clips. You can create 
a separate stream for older versions of the Player, and you can decide whether 
audio or video quality should be given priority during reduced bandwidth 
conditions.
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The Preferences Dialog Box - SureStream page

Player Compatibility

RealProducer Plus allows you to record RealMedia clips that can be played on 
both RealPlayer versions G2 and 5.0. During the recording process, 
RealProducer Plus creates both a G2 stream and a separate 5.0 stream. 
However, you will still need a RealServer G2 to stream the clip.

We recommend that you create G2-only clips to limit file size and processing 
time, unless you are sure you need 5.0 compatibility.

➤ To change RealPlayer compatibility:

1. From the main RealProducer Plus window, choose Preferences from the 
Options menu.

2. Click the SureStream tab.

3. Select the version of RealPlayer you want your RealMedia files to be 
compatible with from the Player Compatibility drop-down list.

4. Click OK to close this dialog.
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Emphasize Audio or Video

This option allows you to choose whether your clip will emphasize audio or 
video when a RealPlayer’s connection degrades and must switch to a lower 
bandwidth stream. Choosing audio means that video quality will be sacrificed 
before audio quality. Choosing video means that audio quality will be 
sacrificed before video quality.

➤ To change SureStream emphasis:

1. From the main RealProducer Plus window, choose Preferences from the 
Options menu.

2. Click the SureStream tab.

3. Select whether to emphasize audio or video during duress conditions.

4. Click OK to close this dialog.

Customizing Target Audience Settings
RealProducer Plus gives you the option to adjust the settings for a particular 
target audience. Each target audience setting is an array of various codecs 
(compression/decompression algorithms) and other settings that work best 
for that particular target bit rate.

The quality of the recorded output is affected by these settings and by the 
actual content (for example, fixed camera shots, amount of motion, and 
multiple camera shots).

There are two types of target audience settings: settings for video clips, and 
settings for audio-only clips. The following sections describe how to modify 
each type of setting.

Settings for Video Clips

Target audience settings for video clips are used to determine how 
RealProducer Plus creates RealMedia from your combined audio and video 
input when various target audiences are selected. These settings include an 
audio codec, a video codec, maximum frame rate, and target bit rate.

➤ To modify target audience settings for video clips:

1. In the main RealProducer Plus window, choose Target Audience 
Settings>for Video Clips from the Options menu.
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The Target Audience Settings - Video Clips dialog opens to the Audio 
page.

2. Select a Target Audience from the list of target bit rates. See “About Target 
Audiences” on page 16 for more information.

3. Select an audio codec for each type of audio format.

When you select a codec, read the description below. This helps you 
determine whether the codec is appropriate for the target audience. The 
frequency response supported by the codec is also listed.

4. Click the Video tab.
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5. Select a Video Codec. RealProducer Plus currently has one video codec 
available, RealVideo G2.

6. Choose a Max Frame Rate setting by sliding the bar. This sets the 
maximum frame rate at which you want to record video.

At lower values, the output emphasizes image clarity at the expense of 
smooth-looking motion. For example, if your content contains a lot of 
motion and you set the slider closer to the 7.5 fps setting, the resulting 
video image will be clearer, but will exhibit choppier motion.

You cannot set the frame rate higher than the input file’s frame rate.

7. Click on the Target Bit Rate tab.
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8. Enter the Target Bit Rate for the entire encoded file.

Generally, you should reduce the expected total bit rate by 25% to 
compensate for connection and packet overhead. For example, choose 20 
Kbps for a 28.8 Kbps modem.

9. Click OK to save the target audience with the new settings and return to 
the main window.

Tip
You can click Restore Defaults at any time during the 
above steps to delete your changes and return the target 
audience to its original settings.
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Settings for Audio-Only Clips

Target audience settings for audio clips are used to determine how 
RealProducer Plus creates RealAudio from your audio-only input when 
various target audiences are selected. These settings include an audio codec 
and whether you are creating a stand-alone clip, or for use in a multimedia 
presentation with other RealMedia (RealVideo, RealPix, RealText, and 
RealFlash).

➤ To modify a target audience for audio-only clips:

1. In the main RealProducer Plus window, choose Target Audience 
Settings>for Audio Clips from the Options menu.

The Target Audience Settings - Audio Clips dialog opens.

2. Select a Target Audience from the list of target bit rates.

3. Select an audio codec for each type of audio format.
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When you select a codec, read the description below. This helps you 
determine whether the codec is appropriate for the selected target 
audience.

4. Select the Audio Mode:

• Choose Audio Only if the RealAudio clip is to be played by itself.

• Choose Multimedia Presentation if the RealAudio clip is to be 
played as part of a multimedia presentation, such as a SMIL 
presentation.

5. Click OK to save the target audience with the new settings and return to 
the main window.

6. You can click Restore Defaults at any time during the above steps to 
delete your changes and return the target audience to its original setting.
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 Chapter 5: RECORDING TIPS
Because there is no single best process for delivering all types of 
streaming audio and video, this chapter shows you various tips on 
how to get the most out of your RealProducer Plus recording 
session.

This chapter discusses how to:

• improve RealProducer Plus performance

• use RealProducer Plus more effectively

• produce high-quality audio

• produce high-quality video

Improving RealProducer Plus Performance
A number of factors can influence how much of your system’s resources are 
used during a recording session. Use these tips to get the best performance 
possible.

Multiple Streams

Generally, the more streams you create in a SureStream clip, the more 
processing power you need. Recording for more than two or three customized 
target audiences that each use a broad range audio codecs, or creating a 5.0 
compatible stream can all effect performance.

Use the Statistics dialog to monitor performance, and then adjust target 
audience settings to get the performance you want. See “Monitoring Real 
Time Performance” on page 19 and “Customizing Target Audience Settings” 
on page 39 for more information.
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Disabling Viewers

By disabling the input source window, the output source window, and the 
audio level meter, you can lower the amount of processing power needed to 
record. Consequently, you can decrease the time it takes to record your clip.

➤ To disable viewers during recording:

1. Choose the View menu from the main RealProducer Plus window.

Viewers that are currently active are designated with a checkmark:

• Input Source

• Encoded Output

• Audio Meter

2. Select a viewer to disable it.

Using RealProducer Plus Effectively
RealProducer Plus has features that allow you to more easily use RealProducer 
Plus and increase efficiency while recording your media clips. Here you will 
learn how to drap-and-drop clips into RealProducer Plus.

Drag-and-Drop Recording

RealProducer Plus supports drag-and-drop recording. This feature allows you 
to quickly convert an input audio or video file into RealMedia.

➤ To use drag-and-drop with RealProducer Plus:

1. Click an input file icon and drag it onto an open RealProducer Plus 
window.

This opens a new session with path and file name information entered 
appropriately.

2. Enter any descriptive information (title, author, and copyright) and 
customize recording settings before clicking Start.

You can also record multiple files at once using RealProducer Plus. Select all 
input files that you want to convert to RealMedia, and drag them onto the 
RealProducer Plus main window.
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Producing High-Quality Audio
This section describes how to successfully create quality sound for RealMedia 
clips. It gives you overall audio tips, describes audio sampling rates, and shows 
you how to use the audio level meter.

General Audio Tips

Follow these tips in order to get the best quality from your audio files.

• Use high-quality source files.

• If your original audio file signal exceeds the acceptable amplitude range, 
the file may be “clipped.” Clipping can give rise to clicks or pops on 
playback. If your source file contains a clipped signal, your final 
RealMedia file will have high-frequency background noise or static. 
Lowering the input volume will help reduce clipping.

• Cut any unnecessarily long silences from the beginning or end of the 
output file to conserve space.

Audio Sampling Rates

The following sampling rates for your source audio are supported for this 
version of the product. For fuller sound, use the higher sampling rates and a 
better audio codec.

• 8000 Hz 

• 11025 Hz 

• 16000 Hz 

• 22050 Hz 

• 32000 Hz 

• 44100 Hz 

Using the Audio Level Meter

While you record RealMedia clips, you can monitor the Audio Level to be sure 
you are encoding the optimal dynamic range. Green indicates a normal 
reading. Red warns that you are close to an over-modulated input. The best 
sound quality will occur when the top red bar is often lit but the clipping 
indicator (the red light above the meter) is never lit.
47



CHAPTER 5: Recording Tips RealProducer Plus User’s Guide
Clear the clipping indicator during recording by clicking on it. This allows you 
to track if audio clipping is occurring without watching the audio level 
constantly.

Producing High-Quality Video
This section describes how to successfully create quality video for RealMedia 
clips. Follow these tips in order to get the best quality from the different types 
of video sources.

Sizing the Image

RealProducer Plus supports any size image from video files, but it will 
automatically crop the height and width to multiples of 4. The most common 
video image sizes are 160 x 120, 176 x 144 pixels, or 320 x 240 pixels.

Cropping the Image

RealProducer Plus’s cropping feature allows you to record any portion of a 
video image that you wish. By cropping an image, you can reduce the overall 
bit rate of your recorded clip while removing unnecessary image space.

The smallest size that you can crop an image to is 32 x 32.

➤ To crop a video image:

1. To edit the image cropping settings, select Crop Settings from the 
Options menu.

The Image Cropping window opens showing the current coordinates of 
the cropped clip.

2. In the main window, click and drag the mouse pointer over an area of the 
Input Viewer.

A white rectangle appears designating the cropped area. The new 
coordinates appear in the Crop Settings window.

3. You can also use the Crop Settings buttons to adjust the size and location 
of crop lines. All dimensions will automatically adjust to a multiple of 4.

4. Click OK to close the Crop Settings window.

5. Select Crop Enabled from the Options menu.
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6. Click the Start button to start the recording process using the crop 
settings.

The cropped image appears in the Encoded Output viewer.
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 Chapter 6: USING APPLESCRIPT
 is 
RealProducer Plus is installed with an AppleScript version that 
allows you to create streaming media files (.rm files). You should be 
completely familiar with AppleScript and RealProducer Plus before 
you read this chapter.

Commands
The following tables describe the different commands necessary to create a 
recording session. See “Examples” below to see how to use them in an 
AppleScript file.

Session Parameters

Sets the input and output parameters for the recording session.

Parameter Descriptions

Parameter Accepted Values Description

Input any valid file name file to be encoded; either Input or 
Input Folder parameter is required

Input Folder any valid folder folder containing files to be encoded

Output any valid file name name of the output .rm file; either 
Output or Output Folder parameter
required

Output Folder any valid folder folder for the output files
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Encoding Parameters

Sets the encoding parameters for the recording session.

Parameter Descriptions

Parameter Values Accepted Description

Target Audience Modem_28k
Modem_56k
Single_ISDN
Dual_ISDN
xDSL_Cable_Modem
Corporate_LAN

target audiences used for encoding; 
you may use more than one if File Ty
is set to SureStream (default: last 
selected)

Audio Format Voice Only
Voice with Background Music
Music
Stereo Music

type of audio used (default: last 
selected)

Video Quality Normal Motion
Smoothest Motion
Sharpest Image
Slide Show

type of video used (default: last 
selected)

File Type Single Rate
SureStream

type of file to be encoded (default: la
selected)

Audio Encoding true or false whether or not the audio input will b
encoded (default: true)

Video Encoding true or false whether or not the video input will b
encoded (default: true)

Clip Title any string title of the clip (default: name of the
encoded file)

Clip Author any string name of the clip’s author

Clip Copyright any string copyright date and owner

Emphasize Audio true or false whether or not you want audio to be
emphasized during limited bandwid
conditions; cannot be used with 
Emphasize Video

Emphasize Video true or false whether or not you want video to be
emphasized during limited bandwid
conditions; cannot be used with 
Emphasize Audio

Show Input Source true or false whether or not the input window is 
shown (default: true)

 (Table Page 1 of
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Configure Video

Sets video settings for a target audience.

Configure Audio

Sets audio settings for a target audience.

Show Encoded Output true or false whether or not the output window i
shown (default: true)

Show Audio Meters true or false whether or not the audio meter is 
shown (default: true)

Parameter Descriptions (continued)

Parameter Values Accepted Description

 (Table Page 2 of

Parameter Descriptions

Parameter Values Accepted Description

Target Audience Modem_28k
Modem_56k
Single_ISDN
Dual_ISDN
xDSL_Cable_Modem
Corporate_LAN

choose one target audience to set

Max Frame Rate any real number (up to 30) the maximum frame rate of the outp
clip

Parameter Descriptions

Parameter Values Accepted Description

Target Audience Modem_28k
Modem_56k
Single_ISDN
Dual_ISDN
xDSL_Cable_Modem
Corporate_LAN

choose one target audience to set

Audio Format Voice Only
Voice with Background Music
Music
Stereo Music

choose one audio format to set; if no
specified, will use the Encoding 
Parameters setting

 (Table Page 1 of
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Configure Bit Rate

Sets bit rate settings for a target audience.

Audio Codec Voice6_5
Voice8_5
Voice5
Voice16
Voice32
Voice64
Music6
Music8
Music11
Music16
Music20
Music32
Music44
Music64
StereoMusic20
StereoMusic32
StereoMusic44
StereoMusic64
StereoMusic94

the actual audio codec used during 
encoding; use either this parameter o
Audio Codec ID plus Audio Codec 
Flavor parameters

Audio Codec ID string name of the codec; with Audio Code
Flavor, an alternative to Audio Code

Audio Codec Flavor integer bit rate of the codec; use with Audio
Codec ID

Parameter Descriptions (continued)

Parameter Values Accepted Description

 (Table Page 2 of

Parameter Descriptions

Parameter Values Accepted Description

Target Audience Modem_28k
Modem_56k
Single_ISDN
Dual_ISDN
xDSL_Cable_Modem
Corporate_LAN

choose one target audience to set

Bit Rate any real number the target bit rate of the output clip
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Crop

Crops the output video to dimensions that you set.

Start

Starts encoding. (No parameters needed.)

Examples
The following AppleScript example records foo.mov into a RealMedia file for 
28 and 56 Kbps audiences, audio set to voice only, video set to normal, file 
type set to SureStream, and “The Title” as the title of the clip. The output file 
is called foo.rm and is cropped.

tell application "Real Producer Plus"

activate

Session Parameters Input file "MyComputer:Movie Files:foo.mov" Output¬
file "MyComputer:Movie Files:foo.rm"

Encoding Parameters Target Audience {Modem_28K, Modem_56K} Audio¬
Format Voice Only Video Quality Normal Motion Clip Title "The Title"

Crop Left 39 Top 88 Width 112 Height 84

Start

end tell

The following example configures video, audio, and bit rate target audience 
settings for 28 and Dual ISDN modems, then it encodes all files within the 
Movie Files folder using these settings.

Parameter Descriptions

Parameter Values Accepted Description

Width any integer the width of the output video (in 
pixels)

Height any integer the height of the output video (in 
pixels)

Left any integer left offset of the output video (in 
pixels)

Top any integer top offset of the output video (in 
pixels)
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tell application "Real Producer Plus"

activate

Configure Video Target Audience Modem_28K Max Frame Rate 15.0

Configure Audio Target Audience Modem_28K Audio Format Voice Only¬
Audio Codec Voice6_5

Configure BitRate Target Audience Modem_28K Bit Rate 20.0

Configure Video Target Audience Dual_ISDN Max Frame Rate 15.0

Configure Audio Target Audience Dual_ISDN Audio Format Voice Only¬
Audio Codec Voice8_5

Configure BitRate Target Audience Dual_ISDN Bit Rate 80.0

Session Parameters Input Folder "MyComputer:Movie Files" Output Folder¬
"MyComputer:Movie Files"

Encoding Parameters Target Audience {Modem_28K, Dual_ISDN} Video¬
Quality Normal Motion Clip Title "The Title"

Start

end tell �
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.snd files, 7
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Start button, 6
Statistics, 17

audio, 20
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video, 21

Stereo music, 11
Stop button, 6, 14
Streaming, 5

multiple streams, 45
SureStream, 9

about, 16
compatibility, 38
emphasize audio/video, 39
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System resources, 19, 45
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Temp directory, 37
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